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Caution
Please keep the following rules.

• Take off your shoes, change into slippers. No food or drink. Clean up 

the garbage.

• Contact with the staff immediately when you encounter machine 

trouble. Emergency contacts are mentioned beside the entrance.

• Don’t use the machines roughly.

• Don’t take out equipments of this laboratory.

• Keep valuables yourself. Lock a door of this laboratory when you 

leave here.

• Return to original setting after using if you change parameters of 

software and hardware.

• Don’t connect your USB memory to XPS-PC. Use the USB of this 

laboratory. And take out the data through the PCs for analysis.

• Don’t touch with your hand anything which enter XPS chamber. 

Clean the equipment if you make it dirty.

• Be careful when moving the stage. Do not neglect the visual check.

• Reserve XPS before using by yourself. And use the machine on time. 

If you want to change your reservation, please cancel by the day 

before. Cancellation on the day is invalid.

• It is the responsibility of your laboratory if equipment fails due to 

operation not described in this manual. Students must let your 

supervisor know. 

• If you use first time, contact the facility staff before using and take 

the training.

• Don’t enter fragile sample, too big sample, gas exhaust sample to the 

XPS chamber without permission. Please contact the staff in advance 

if you are worried.

• When using the transfer vessel, be sure to contact the facility staff.
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Write your name and start time 
in the “logbook” and write finish 
time and parameters after using. 
Check the analytical chamber 
vacuum before use and write the 
value. Use as scheduled. Change of 
reservation on the day is invalid.

Check the Ar⁺ etching gun 
chamber vacuum and the 
analysis chamber vacuum. 
Normally,
✓ Ar⁺ etching gun ~10−4𝑃𝑎
✓ Analysis chamber ~10−7𝑃𝑎

If the degree of vacuum is 
significantly deteriorated, inform  
facility staff.

Ar⁺ etching 
gun chamber

Analysis 
chamber

Press the “Channel / float voltage” 
button on the ion gun unit to light 
it up and confirm that the display 
number is "7“.

The current and voltage conditions of the 
ion gun are input to each channel, and the 
ion gun is set by selecting the channel 
number. Channel "7" is a setting that does 
not use etching gun.

Ion gun unit

Before using
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Set your sample on the sample holder. 
Holders are stored in the vacuum 
desiccator. Use normal holder for normal 
sample.

Use the large holder for large samples (less than 
100mmφ). Please contact staff for samples that 
are worried about setting, such as samples that 
easily emit gas, are too thick or fragile.

 a sample is fixed to the holder using the 
Fastener or carbon tape. Make sure the 
sample is completely fixed.

• About powder samples
Use carbon tape or attach (press) to a 
metal thin film (Al, In, Si, etc.). Blow using 
blower at least 30 times to completely 
remove unbonded powder. Vibrate the 
holder to shake off powder. If even small 
amount of powder scatter in the chamber, 
the device will break down. If it causes a 
breakdown, we will charge a repair fee. 
Do not put pelletized powder if it is 
cracked or chipped when setting.

Normal holder
(spare)

Normal holder

Holder for 
charged sample

Cover of Holder 
for charged 
sample

Large holder

Fastener Holder base

Remove the bottom plate 
of the holder when the 
sample is thick.

Make sure to clamp both sides of a sample. Set a sample 
does not move even if the holder is upside down. Pay 
attention to the positional relation  between the X-ray 
source and fastener & sample.

Sample preparation
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・Holder for charged samples
By applying a bias voltage to a sample, 

the charge reduction using the 
neutralizing electron gun is made more 
effective.

Applying + 100V to the bottom of a sample and 
applying a potential difference to the cover of the 
GND allows the neutralizing electrons to be 
efficiently applied to a sample surface. And it has 
the effect of suppressing surface potential deviation 
due to etching when  Ar+ ion etching.

Mount the sample as shown in the 
photo, cover and fix. The sample 
thickness is limited to 1.3mm. Set the 
cover so that do not tough the copper 
plate of the holder. Make sure a sample 
surface is below the cover. Confirm that 
there is no conduction between the 
holder cover and terminal.

・About contamination
 To prevent surface contamination in the air, samples prepared by the dry process should be 
wrapped in aluminum foil or stored in a vacuum device immediately after preparation. Samples 
prepared by the wet process are washed with pure water after washing with acetone. Immediately 
blow with air duster and wrap in aluminum foil.

・About reference peaks
 It is convenient to prepare reference peaks in a sample to correct the charge shift of a sample. 
Samples containing carbon may be more necessary because they may not be available for reference 
because C1s peak of the contamination and the carbon peak from a sample overlap. For example, Au 
thin film or mesh is placed together for measurement, or a sample is coated with Au and measured 
together, or in the case of a powder, other powder whose chemical state is known is mixed and 
measured together It is better to do.

Sample preparation (Appendix)
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Set into the sample exchange chamber

Set the holder into the sample exchange 
chamber and vacuum evacuate. Unlock 
the chamber and press “VENT” button to 
return the chamber to atmospheric 
pressure. Put the holder horizontally on 
the rail in the chamber, and close it to 
the back. 
 Turn(any direction) the magnet ring on 
the sample replacement rod to change 
from "OPEN" to "CLOSE“. Turn the ring to 
raise the hook under the rail. Look into 
the bottom and check that the hook is in 
the hole on the back of the holder.
 Check that the ring is retracted to the 
rear. Close the door, lock it and press the 
“VENT” button again to evacuate.

If this setting fails, the holder cannot be introduced 
into the analysis chamber. Check it is set properly.

1

2

VENT

Check 
with eyes

Vacuum gauge of sample 
preparation chamber

Evacuation of the 
sample takes about 30 
minutes for metal plates 
and about 2 hours for 
powder samples using 
carbon tape. Startup XPS 
device while waiting.

Wait more

Check 
no gaps

Magnet ring & Sample 
replacement rod

Don’t touch

Sample exchange chamber

Back of holder
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Turn on the chiller first. Next, press “SPEC” 
button and “X-R” button to light up.

The chiller power supply is always first. Pressing X-R button 
activate another chiller(you will hear motor sound). If the 
chiller is not running, press X-R again.

SPEC

X-R

Turn on the stage lamp, the camera power, 
the camera monitor, XPS-PC, and PC 
monitors. After starting the PC, click 
"SPECSURF Acquisition" on the desktop to 
launch the XPS software.

Stage lamp
Camera power

Camera monitor

CCD stage camera
Don’t touch

For analysis

Select “XPS” from the 
Acquire menu to open 
XPS acquisition window 
(if not, PC reboot)

Chiller

Startup equipment
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First, select the type of X-ray 
source from the following list.
・Mg-Kα X-ray
・Al-Kα X-ray
・Monochrome X-ray (Al)
Turn on the “Al/Mg” button for 

Mg, and turn it off for Al. For 
monochrome X-ray, select Al and 
press the “MONO/STD” button to 
turn it on.

After selecting the X-ray source, 
turn on the power of FILAMENT, and 
turn the ADJ knob slowly to increase 
the current to 3.5 A. Wait for 5 
minutes after increasing.

Switch the display to “X-RAY 
POWER” and turn on the X-RAY 
power(Rightmost button). Increase 
the voltage knob by 1 kV every 3 
minutes to 10 kV. After another 3 
minutes, increase the current knob 
by 5 mA to 10 mA.  For 
monochrome X-rays, increase these 
by one every 3 minutes to 12kV and 
25mA.
Turn on analyzer power.

Analyzer power

For monochrome

Startup equipment

This is Al-Kα X-ray



Measure size left right

3.0mmφ 36 36

1.0mmφ 24 12

0.7mmφ 12 10

0.2mmφ 12 8

0.03mmφ 4 1 9

Select the Source tab from XPS 
Acquisition in SPEC SURF, enter the 
type of X-ray source and voltage and 
current values, and click “On” in 
Status.

When the Status display changes 
to “Update”, press the 
“AUTO/MANU” button on the X-R 
POWER unit to switch to “AUTO”.

The measurement area can be set 
by using the two apertures shown 
in the left picture. Loosen the 
locking screw and turn the 
aperture in the CLOSE direction to 
decrease the number, or in the 
OPEN direction to increase it to 
match the number in the table on 
the left. Be careful not to turn it 
too far. 36 is 0 after one turn in 
the OPEN direction.
For depth profile, please set 1 

mmφ or 0.7 mmφ.

screw
CLOSE

OPEN

Startup equipment
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Transfer into analysis chamber

Move the stage to the sample 
exchange position. Press “P/M” 
button on the stage controller to 
switch the display to MEMORY, then 
use “UP” and “DOWN” buttons to 
select the memory No. SE. Press 
“MOVE” button to move the stage to 
the displayed position. Basically, the 
stage will not move because it is 
already, but be sure to check it.

After the sample preparation chamber is 
sufficiently evacuated, press the “V1” 
button. Move the magnet ring to the right 
to transfer the holder to the analysis 
chamber. Send it while checking the 
analysis chamber from the viewing port. 
When you put it to the end, turn the ring 
to change it to “OPEN” and return the ring 
to the left end. Press “V1” button again. If 
you notice anything unusual, please call 
facility staff.

Sufficient 
vacuum

1

2

3

The stage will fit in the 
groove on the back of the 
holder.

Move it to a position 
where it cannot move.

Turn the magnetic 
ring and pull it out.

Stage controller
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Transfer into analysis chamber
After the V1 valve is closed, check the 

vacuum level in the analysis chamber. If 
the vacuum is worse than 5.0 × 10−6Pa
, return the holder to the sample 
preparation chamber immediately, 
continue vacuuming for a while, and 
then retransfer the holder. Wait until 
the vacuum decreases 10.0× 10−7Pa or 
lower.
 Operate the stage lever to move the 
holder. The center of measurement is 
the cross on the camera monitor. When 
there are several samples, use the 
position memory function. Switch to 
MEMORY mode with “P/M” button, 
select the No. to be memorized with 
“UP” and “DOWN” buttons, and press 
the “ENT” button to memorize the 
current position.

When aligning the 
measurement position, be 
sure to align the Z-axis as 
well. Zoom the camera to 
find the Z value that the 
camera will focus on.

Zoom up

Don’t touch camera 
body

Stage lever
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Setting of monochrome X-ray(Appendix)

Increase the monochrome X-ray output 
to 12 kV and 25 mA in advance. Contact 
the staff when using the unit for the first 
time.

 Loosen the lock screw on the left 
picture switcher in the center of the 
main unit and change it to monochrome.

 Change the position of the X-ray source 
from 45 mm to 40 mm by turning the 
knob shown in the left photo at the 
back of the device.

After transfer the holder, move it to the 
analysis position, change stage tilt to -
10°. Select “Acquire”→”Ratemeter” in 
the software, enter the main peak value 
of the element to be measured in 
Centre in the Ratemeter window, and 
click “Start”. Find the value on the stage 
Z axis where the peak intensity is 
highest, register that position in stage 
controller. Change the Ratemeter values 
for “Pass, Dwell, Refresh time”. so that 
you can easily see the increase or 
decrease in peak intensity with Z 
movement. If high intensity is not 
possible, there is a way to tilt up to -
20°. Please refer to “Angle Resolved” 
to remove the tilt limitation. Contact 
staff when using.

locking 
screw 

X-Ray Source 
Position Scale

Be careful not to 
accidentally touch 
other parts 

switcher

Ratemeter cannot be selected 
until XPS acquisition is closed.
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Set up the Ar⁺ gun when you want to remove contamination from the 
sample surface or measure the depth profile. Contact the staff when 
you use it for the first time.

Use a measurement size of 1 mmφ or 0.7 mmφ. Ar⁺ etching may 
affect the chemical state and composition of the sample surface. The 
etching area is 3 x 3 mm centered on the camera display position.

After transfer the holder, wait until the 
vacuum in the analysis chamber is less than 
10.0× 10−7Pa.

Press ”AVC” button on the 
vacuum gauge of Ar⁺ gun. Turn 
the Ar gas valve on the left 
picture slowly counterclockwise 
to adjust the vacuum to 
10.0×10-2Pa. The valve always 
has a marker at 6 o‘clock 
direction. About one turn will 
adjust the vacuum to 10.0×10-

2Pa. Watch the vacuum gauge 
and turn it carefully. Too much 
Ar gas will damage the 
equipment. Wait 10 minutes 
after equilibrium is reached.

Turn the valve 
at the back

Turn the lever of the auto valve controller 
to ON. the Ar gas valve will start to tighten 
and the vacuum of the Ar⁺ gun will drop 
temporarily.

Auto valve controller

Ar gas valve

Vacuum gauge of Ar⁺ gun

Setting of Ar⁺ etching gun(Appendix)

This is too much gas. 
Tighten the valve!
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Press the Channel button on the Ion 
Gun unit and turn the X knob to select 
the etching condition. The conditions 
are as shown in the table below.
Etching rate is measured on SiO₂.

Select “Depth Profile” in Experiment tab, 
select Profiling tab, enter channel number 
to be used in Preset, enter Gas Pressure 
value in above table to Gas Pressure, and 
click Set.
If you want to do Depth profile, go to 
"Depth profile" page.

Etching can be started by pressing 
“Irradiation ON/OFF” button in Ion 
Gun unit, and the elapsed time of 
etching will be shown on the display 
by turning on “Timer Display” (the 
time will be reset by pressing “Timer 
Reset”).

Setting of Ar⁺ etching gun(Appendix)

2023/7/28update

previous rate

9.0

channel Ch1 Ch2 Ch3 Ch4 Ch5

Beam energy(eV) 3000 2000 1000 500 3000

Emis current(mA) 20 20 25 25 20

Gas Pressure(Pa/100) 9.5 9.5 7.0 6.5 9.5

Etching rate(nm/min) 6.0 4.0 1.5 0.3 5.5

Etching rate(nm/min) 6.0 5.0 2.0 0.5 6.0
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In the case of non-conductive 
samples, non-uniform charging 
may occur on the sample surface. 
The non-uniform charging affects 
the energy value and the half 
width. The use of charge 
neutralizer can alleviate the 
charging phenomenon by 
supplying electrons to the sample 
surface.

Neutralizer unused Neutralizer used

Glass sample

・How to use charge neutralizer
1. Power on charge neutralizer 

unit
2. Press “SEL” button to 

change the ADJUST item to 
“FIL”. and turn the ADJ knob 
to increase the current 
value slowly to 6.0A.

3. Select Ratemeter from 
Acquire in the software 
menu. If XPS Acquisition is 
open, close it first.

Setting of charge neutralizer(Appendix)

charge neutralizer unit
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4. Enter the photoelectron peak 
position of the sample in “Centre”, 
and change “Pass, Dwell, and 
Refresh time” to appropriate 
values to make it easier to see the 
peak shape. Click “Start” and 
check Intensity value.

5. Turn on “Acc.V” on the unit, 
change the ADJUST item to Acc.V
using the “SEL” button, and turn 
the ADJ knob to change the 
voltage value while searching for 
the voltage value that has the 
highest peak count and the proper 
peak position.

6. Once the voltage value is 
determined, close the Ratemeter 
and measure wide and narrow 
scan. The appropriate voltage 
value is different for each sample.

When using the holder for charged samples
Before setting up the neutralizer, turn on the 

device as shown in the left figure and apply 
voltage to the holder.

1. POWER On, and OUTPUT On.
2. Turn the current knob to apply a 

small amount of current.
3. Turn the VOLTAGE knob to set to 

100.0V.

DC power supply device

Setting of charge neutralizer(Appendix)
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Always contact facility staff when 
using a transfer vessel. Do all work 
carefully.
Do not give any shock to the 

transfer vessel. Make sure that 
there is no dust on the O-ring. Be 
careful when transferring the holder.
After fixing the sample to the 

holder in the glove box, mount the 
holder in the transfer vessel. Pay 
attention to the direction of the 
holder when mounting it (see the 
figure on the left). Turn the 
opening/closing knob to tighten it 
firmly.
Remove the lock of the sample 

preparation chamber door and 
remove the blank flange from the 
door after VENT.

Holder for transfer vessel

Transfer vessel

Do not touch the left part from 
here with your bare hands!

Fix the holder in this orientation.

Blank flange
Do not touch the inner part 
with your bare hands!

Opening/closing 
knob

Setting of transfer vessel(Appendix)
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Align the pins to attach the transfer 
vessel to the door and turn the fixing ring 
to fix it to the door. Lock the door and 
press the VENT button to evacuate. 
When the vacuum in the sample 

preparation chamber exceeds 
0.5×10⁻³Pa, carefully turn the 
opening/closing knob to open the vessel 
little by little. Opening the vessel too large 
will cause the pump to malfunction. 
Check the vacuum level and open the 
vessel carefully.

Fixing ring

When evacuate, push the 
vessel body in a little by hand.

Stop opening. Wait until 
the L lamp lights up.Open the vessel slightly.

Once the vacuum in the vessel is drawn, fully 
open the opening/closing knobs. Operate the 
magnetic ring to receive the holder and close 
the vessel. When the vacuum in the sample 
preparation chamber is drawn, open V1 and 
transfer the holder into the analysis chamber.

Setting of transfer vessel(Appendix)

Close V1 valve.
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Wide scan

There are a total of six different 
measurement methods. It is 
recommended to start with a wide scan 
for all measurements.
Select “Wide scan” in Experiment.

Select “None” for Movement to measure at 
the current stage position or select 
“Memory” to use the memory position of 
the stage controller.

Select the measurement size in Lens Mode.

Input the first number (First) and the last 
number (Last) of the memory number for 
continuous measurement in the Stage tab 
(when Memory is selected). Set each 
condition of Wide scan in Regions tab. 
Mainly check the Start(eV) value and the 
number of scans. If you want to see peaks 
on the high energy side, increase the start 
value, and if you want to see small peaks, 
increase the number of scans.

Click “Start” to start measurement 
and click “Check” to display the 
estimated measurement time.
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Markers

Use markers to identify the peaks that 
appear in the wide scan spectrum. Click 
Markers icon on the left.

A line will appear on the spectrum. When 
you put the line to the peak position, a list of 
elements will be displayed in “Suggested 
Peaks”. Select an element from the list and 
click “Add” to stamp the element name on the 
graph. And you can select from “Element” item. 
Some elements also have a Chemical Shift list 
that can be stamped as well. Clicking OK at the 
end will leave the stamp.

You can see the spectrum of the standard 
sample in the XPS handbook, so please refer 
to it.

The position of the marker is based on 
the standard, so it may be different 
from peak position of the actual sample.

Handbook 
icon

In addition to the photoelectron peak, various satellite 
peaks appear in the spectrum. In particular, the K-α₃,₄ 
satellites appear at 10 eV lower energy than the 
photoelectron peak. And when using Mg-Kα, Satellite 
peaks called "ghost peaks” derived from O-Kα(730eV 
higher), Al-Kα(230eV lower), Cu-Kα(320eV higher) appear. 
When using Al-Kα, same satellites appear.(960eV higher(O-
Kα), 230eV higher(Mg-Kα), 560eV higher(Cu-Kα)) 
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Narrow scan
It has a high energy resolution and mainly 

acquires the spectrum of the main peak of 
each element. Select Narrow scan in 
Experiment. For Movement and Lens Mode, 
refer to "Wide scan".

Set the memory number in the Stage 
tab (when using Memory position, see 
"Wide scan"). If the measurement 
contents are different for each sample, 
you can set the group. Enter a group 
name in “Groups”, click “Add”, enter the 
memory number in First and Last, and 
select a name from “Group”.

Select “Group” in the “Regions” 
tab (when using the Group 
function), select the element to be 
measured from “Element”. Open 
the measured wide scan spectrum 
and click the "Select region" icon 
to display Start (green) and Finish 
(red) lines on the spectrum. Adjust 
the line position according to the 
peak to change the measurement 
range. Set the number of scans to 
about 10~100. More scans will 
take more time, but will reduce 
the noise.Select region
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Narrow scan

If you click “Pause” in “Acquisition 
Status”, the measurement will be 
interrupted after one scan, and only the 
number of scans can be changed. After 
changing, click “Continue” to restart the 
measurement. Pressing “Stop” will end 
the measurement after one scan cycle, 
“Abort” is force termination.

・About the spectrum window
 When the mouse cursor is placed on the spectrum, 
the energy position and intensity are displayed in the 
lower right of the spectrum window. In the upper left 
corner, there are icons to adjust the display scale. The 
spectrum obtained by continuous measurement is 
stored in one window. You can change the display of 
each sample, each region, and each level from the 
menu at the top right of the spectrum window.
 Save, Open, etc. of data are also done in each 
window. In the spectrum window, sample numbers 
are assigned from 0. Don't make a mistake with the 
sample number.

Scale icons
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Depth Profile

By repeating the Ar⁺ etching and 
measurement alternately, the 
depth profile can be obtained. 
Contact the staff when you use it 
for the first time.
 
Select “Depth Profile” in 

Experiment and adjust Ar gas 
pressure of the etching gun (see 
“Setting of Ar⁺ Etching gun"). 
Select “Full” in Acquisition Mode. 
If you select “Separate” or “Simultaneous”, you can 

set the energy positions of Peak and Background and 
acquire only their differential intensities. Since no 
spectrum is acquired, the measurement can be 
performed at high speed. (See "Image & Linescan")

Set the etching time in “Profiling” 
tab. 
“Regions” settings are the same as 

"Narrow scan".
Etching changes the state of the 
surface potential and chemical 
state, and the peak position may 
move significantly, so you should 
measure a little wider.
Atomic mixing, selective 

sputtering, etc. may need to be 
taken into account in the analysis.

In the upper image, the etching time is 
set to 0 seconds before the first 
measurement (in the unit of level), each 
15 seconds before the second to fourth 
measurements, and each 60 seconds 
before the fifth to tenth measurements. 
The total etching time is 405 seconds.
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Angle Resolved
By measuring the spectrum while the 
stage is gradually tilted toward the 
analyzer axis, the depth profile of the 
sample can be obtained nondestructively. 
Contact the staff when you use it for the 
first time.
The stage can be tilted up to 80° to 
obtain a depth profile from 6 nm to 1 nm. 
A high tilt angle extends the area of the 
surface to be measured in the Y-axis 
direction, increasing the amount of signal. 
It can be applied to the analysis of minute 
amounts of components. 
The stage will be moved a lot, so please 
be very careful.  After analysis, be sure to 
restore the settings of both hardware and 
software. After measurement, be sure to 
delete the positions registered in the 
memory function.

・Setup of the XPS main unit
Transfer the holder to the analysis 
chamber. Be sure to fix the sample firmly 
as it will be tilted. Loosen the locking 
screw and turn the micrometer of the 
magnetic lens stage to lower it from 
Z=17.95 to Z=8.5. Make sure the switch at 
the bottom is pressed (you should hear a 
small click. Be careful not to lower it too 
far or it will break). Tighten the loosened 
locking screw again.  

Magnetic lens stage

Magnetic lens

Locking screw

Switch

Micrometer of the 
magnetic lens stage
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Angle Resolved

・Setup in Spec Surf software
Go to "View" -> "Configuration" to launch 

"System Configuration", and select "High 
Angle" for "Sample Holder". the tilt limit will be 
released, allowing you to move the stage from -
30° to 80°. After that, please operate the 
stage with great care. If you only want to do 
wide and narrow scan at high angle, you can 
continue as usual.

Select "Angle Resolved" in the 
Experiment tab, and set the tilt angle of 
the stage in the Profiling tab. In the left 
picture, XPS acquires spectra at each level 
while tilting from 0° to 80° in 5° steps. 
If you want to tilt the stage more than -
10°, be sure to move the position of the 
X-ray source back by 5 mm (see "Setting 
of monochrome X-ray").For the rest of the 
settings, refer to "Wide Scan" and 
"Narrow Scan". 

← If the holder is tilted in the 
minus direction, there is a risk 
of it hitting the X-ray source. 
Basically, it is prohibited. 
Please consult with staff.

Configuration
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Total Reflection

Total Reflection uses monochrome X-rays, and 
by adjusting the position of the stage so that 
total reflection of X-rays occurs, it is possible to 
obtain spectra that are about two-thirds 
shallower than the normal measurement depth, 
and with a better signal-to-noise ratio due to the 
no penetration of X-rays. It is mainly used to 
evaluate contamination on the surface of a 
sample. Only samples with smooth surfaces 
(such as Si wafers) can be measured. Contact the 
staff when you use it for the first time.

・Measurement Method
1. Place the sample in the holder so that 

the sample surface is parallel to the 
stage, and transfer the holder.

2. Set up the monochrome X-ray and 
adjust the Z position while checking the 
photoelectron spectrum of the sample 
with Ratemeter (see " Setting of 
monochrome X-ray ").

3. Select "Total Reflection" in "Experiment", 
tilt 0.2° from -10° to -5°, and 
acquire the spectrum, and check the 
tendency of the signal-to-noise ratio. 
(see " Setting of Total Reflection")

4. Check the spectrum with Ratemeter by 
1° from -4° to -1°, and fine adjust Z 
again to get the intensity.

5. After the Z adjustment, measure at the 
angle with the best S/N ratio. Basically, -
1°.

Wide   BE (eV)
1000 800 600 400 200 0

ar
bi
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y 
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20140328_133719_Wide_
20140328_132916_Wide_

Normal wide scan  Total Reflection scan
You can see that the intensity of the 

contamination C1s peak is about twice 
as large as in the normal measurement. 

C1s

O1s

Si2p

O 1s  BE (eV)
540 536 532 528 524

0

500

1000

1500

2000

check the tendency of the 
signal-to-noise ratio. 
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Image & Linescan
Image can obtain elemental mapping 
images up to 5.0 x 1.8 cm in size. If 
chemical shifts are available, it is 
possible to map the distribution of 
oxides and metals, for example. Contact 
the staff when you use it for the first 
time.

First, obtain a Narrow scan of the 
element you want to measure. Select 
"Image" in "Experiment", and select 
"Separate (PB separate method, easy to 
set up)" or "Simultaneous (PB 
simultaneous method, fast 
measurement)" in "Acquisition Mode".

・Separate
 Set the values of Peak, Bk1, and Bk2 
based on the spectrum of Narrow scan 
acquired in the Regions tab. Only the 
intensity at that energy positions are 
acquired.
・Simultaneous
 Click the Channels column and select 
whether the intensity to be acquired by 
each channel (detector) should be 
Background or Peak. Change the Pass 
value appropriately so that the high 
energy side Background, Peak, and low 
energy side Background of the element 
to be measured.

Separete

Simultaneous

Bk1Bk2

Peak

Acquire the intensity at each energy 
position with 9 detectors, and subtract 
the background intensity from the peak 
intensity to draw the mapping.
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Register the upper-left stage position to 
memory No.1 and the lower-right stage 
position to memory No.2 of the sample 
area for which you want to acquire the 
image using the stage controller.

No.1

No.2

Mapping area

In the Image tab, click "Read" to 
read the memory positions." In 
Scan, select either Size or Step and 
set the resolution of the image. For 
"Mode", select "Image".

←Mapping image obtained by "Image". red:Si
and blue:Au. The image of each element in the 
mapping result can layered in different colors.

Image & Linescan

Select "Linescan" 
for "Mode" to 
perform line profile 
from memory No.1 
to No.2 position.

Si peak
(SiO₂)

Si peak 
(Si)

←Linescan results by 
Simultaneous method. This is a 
Si wafer etched with Ar⁺ in 
the center.

Si(SiO2)

Si(Si)
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Saving data
All measured spectrum data are 
automatically saved with the name of 
the date, measurement method, and 
X-ray source  in “Auto Storage” folder.  
Select the Auto Storage folder from 
"File" -> "Open", select the data, the 
details of the data will be displayed at 
the bottom of the save window.
To save the spectrum in a different 
format, select "File" -> "Save as" and 
choose the file type.In addition to 
SpecSurf data, text format and VAMAS 
format can be output.
You can output the spectrum as an 
image in report format by clicking 
"File" -> "Report". You can also paste 
the spectrum as an image by clicking 
“copy“ on the spectrum window. 
If you want to keep the data on this 
XPS-PC, please save them in a folder 
“data”. Please keep a folder for each 
laboratory.
Basically, please bring back the 
measurement data by yourself. We 
cannot guarantee the preservation of 
the data.

Open, Save & 
Copy icon

Save in each 
lab folder

Report image



30

End procedure

・ Using the holder for charged samples
Return the voltage and current values of DC power supply device to 0.
OUTPUT OFF.
POWER OFF.

・ Charge neutralizer
Return the voltage and current values to 0.
Acc.V OFF.
Unit Power OFF.

・Using Ar⁺ etching gun
Auto Valve Controller OFF.
Close the Ar gas valve clockwise to about 9 o'clock (1/4 turn). 
Wait for 3 minutes.
Close the Ar gas valve clockwise to about 6 o'clock (3/4 turn).
AVC of Ar⁺ etching gun chamber vacuum gauge OFF.

・When Angle Resolved measurement carried out
Move the stage to the sample exchange position.
Return the X-ray source position to 45mm(if it has been changed).
Return the Z-axis of the magnetic lens to Z=17.95 and retighten the locking screw.
Reset the holder setting in “Configuration” to “Standard”.
Delete all position registered in the stage memory.

・ Using monochrome X-rays 
Move the stage to the sample exchange position.
Return the X-ray source position to 45mm.
Return the switcher device to “Baking” and tighten the locking screw.
After 15 minutes have passed since you performed the “X-ray shut down" 
procedure on the next page, press the "MONO/STD" button to return to "STD". 
If the stage tilted above -10 °, perform the procedure described in “When Angle 
Resolved Measurement carried out”. 

・When using the transfer vessel
return the holder to the sample preparation chamber, re-seal the holder in the 
transfer vessel.
Unlock the door and VENT. After VENT, remove the transfer vessel and reattach 
the blank flange to the door.
Lock the door and draw a vacuum in the sample preparation chamber. 

If you  have any of the following uses, please perform the following 
end procedure before the normal end procedure.
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・X-Ray shutdown
Press “Auto/Manu” button to change to “Manual”.
Reset X-Ray current to 5 mA and voltage to 3 kV.
Turn off X-Ray power.
Change the display to show “FILAMENT POWER”.
Turn the ADJ knob of FILAMENT to set the current back to 0.
Turn off FILAMENT power.
Click “Off” in the Source tab of XPS acquisition in Spec Surf.

・ Take out the holder
Press the P/M button on the stage controller to change to MEMORY mode.
Press UP and DOWN buttons to display No.SE.
Press the MOVE button to move to the sample exchange position.
Press the V1 button to open the V1 valve.
Turn the magnetic ring to the “OPEN” position and push it forward.
Turn the magnetic ring to the “CLOSE” position.
Pull the black ring out to the end and return the holder to the sample exchange 
chamber. Press the V1 button again to close the V1 valve.
Open the lock of the sample exchange chamber.
Press the VENT button to return the sample exchange chamber to atmospheric 
pressure. Turn the magnetic ring to “OPEN” and take out the holder.
Lock the sample exchange chamber and press the VENT button to draw vacuum.

・Finish XPS equipment & other tasks
Remove the sample from the holder, clean the holder, and place it in the vacuum 
desiccator to draw vacuum. Clean up the workbench.
Turn off analyzer power HT.
Turn off the camera, camera monitor and stage lamp.
Transfer measurement data to PC for analysis using the USB memory of this Lab.
Shut down Spec Surf, PC and turn off display.
After 15 minutes from X-ray shutdown (when using monochrome X-ray, switch 
MONO/STD to STD), turn off the X-R and SPEC buttons.
Turn off the power of the chiller.
Enter the vacuum level of the analysis chamber and the end time in the logbook. 
When using the laboratory at night, turn off the lights and lock the door.

This is a common procedure for all measurements. Please be sure to 
follow the procedure.

End procedure
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